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Claris FileMaker Pro 22.0.1 Release Notes 
July 2025 

This software updates FileMaker Pro to version 2025 (22.0.1) and addresses issues. If you are unable to 

successfully update to FileMaker Pro 2025 (22.0.1), search the Knowledge Base for installation 

information. 

New features and enhancements 

Artificial intelligence script steps and functions 

Using new capabilities like SQL queries and FileMaker finds by natural language, as well as 

performing agentic operations that can use functionality you define, you now have even 

more ways to surface real intelligence from your data. 

New AI script steps: 

• Perform SQL Query by Natural Language: Sends a natural language prompt and 

database schema to a model, which sends back an SQL query to get a result from the 

database to use in its response. By leaving it to the AI model to create complex SQL 

statements in response to a user's prompt such as "Show me our top 10 highest-value 

deals this quarter," developers can provide their users answers from their data more 

easily and without sending the data itself to a model provider. Includes debug options 

that show developers the schema sent to and the SQL received from the model. 

• Perform Find by Natural Language: Sends a natural language prompt and a list of fields 

on the current layout to a model, which returns a FileMaker find request, and 

performs a find. Includes options to return the found set, or the find request, as JSON. 

• Generate Response from Model: Gets a text response from an AI model given a user 

prompt in natural language. Can perform agentic operations with advanced prompts, 

conversation memory, and tool calls (to perform SQL queries, retrieve images, and use 

FileMaker custom functions). Or you can turn off agentic mode and gain precise 

control over interactions with the model. 

• Configure Prompt Template: Sets up a prompt template to use by name in other AI 

script steps, given a model provider and predefined prompts you can customize. Can 

be used in Perform SQL Query by Natural Language, Perform Find by Natural 

Language, and Generate Response from Model script steps. Start with the predefined 

prompts, customize them, or write your own to achieve an optimal response from the 

model. 

• Configure RAG Account: Sets up a retrieval-augmented generation (RAG) account to 

use by name, given an endpoint and an API key. Use with the Perform RAG Action 

script step to specify the RAG space that you want to use on the AI Model Server 

(installed with FileMaker Server). 

• Perform RAG Action: Sends a prompt to, or adds and removes data from, a RAG space 

on the AI Model Server specified by a named RAG account. Add documents or other 

data to create a knowledge repository that users can ask questions of, reducing a 

model's tendency to fabricate responses, and without sending your data to a third-

party model provider. 

https://help.claris.com/en/pro-help/content/perform-sql-query-by-natural-language.html
https://help.claris.com/en/pro-help/content/perform-find-by-natural-language.html
https://help.claris.com/en/pro-help/content/generate-response-from-model.html
https://help.claris.com/en/pro-help/content/configure-prompt-template.html
https://help.claris.com/en/pro-help/content/configure-rag-account.html
https://help.claris.com/en/pro-help/content/perform-rag-action.html
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• Fine-Tune Model: Fine-tunes a base model on the AI Model Server with your own 

training data set (either from a table occurrence or a JSONL file) to make the model 

better at your specific tasks. Uses low-rank adaptation (LoRA) to add a small number 

of trainable parameters to the model, reducing computation time and memory usage 

over full fine-tuning. 

• Save Records as JSONL: Saves records to a specified JSONL file. Each line in the file is a 

JSON object representing a record. Can be used to output record data for fine-tuning a 

model. 

• Configure Regression Model: Trains, saves, loads, and unloads a regression model. 

Trains a model based on embedding vectors for text data and numeric target data. 

Use the PredictFromModel function to predict a target value from the embedding 

vector for a given input. 

New AI functions: 

• GetFieldsOnLayout: Returns a list of the fields on a layout as JSON data. Includes only 

the fields that are accessible to a find. Useful for debugging what field information is 

sent by the Perform Find by Natural Language script step. 

• NormalizeEmbedding: Normalizes an embedding vector to unit length. If specified, the 

dimension parameter reduces the number of vector dimensions to use before 

normalizing. Allows you to work with custom vectors or use specific dimensions of 

existing vectors for semantic search operations. 

• AddEmbeddings: Adds two embedding vectors and returns the result as a normalized 

vector. Can be used to combine the semantic meaning of two embeddings. 

• SubtractEmbeddings: Subtracts embedding vector v2 from v1 and returns the result as 

a normalized vector. Can be used to isolate or modify semantic concepts in 

embeddings. 

• PredictFromModel: Returns the predicted value from a trained regression model for 

the specified text embedding vector. Use the Configure Regression Model script step 

to train and load a model first. Example uses: Forecast inventory needs for holiday 

sales, predict customer behavior, or analyze trends based on your historical data. 

• GetRAGSpaceInfo: Returns information about the specified RAG space or all RAG 

spaces, if no space ID is specified. Works with the RAG account created by the 

Configure RAG Account script step. 

AI enhancements: 

• Anthropic is now supported as a model provider that you can specify in the Configure 

AI Account script step. See Claris FileMaker 2025 Technical Specifications for the 

supported models. 

• The Insert Embedding in Found Set script step includes these new options (off by 

default): 

• Continue on error continues getting embedding vectors for the found set even 

after errors are encountered in some records. With empty target fields, you 

can more easily find records that encountered errors. 

https://help.claris.com/en/pro-help/content/fine-tune-model.html
https://help.claris.com/en/pro-help/content/save-records-as-jsonl.html
https://help.claris.com/en/pro-help/content/configure-regression-model.html
https://help.claris.com/en/pro-help/content/getfieldsonlayout.html
https://help.claris.com/en/pro-help/content/normalizeembedding.html
https://help.claris.com/en/pro-help/content/addembeddings.html
https://help.claris.com/en/pro-help/content/subtractembeddings.html
https://help.claris.com/en/pro-help/content/predictfrommodel.html
https://help.claris.com/en/pro-help/content/getragspaceinfo.html
https://help.claris.com/en/pro-help/content/configure-ai-account.html
https://help.claris.com/en/pro-help/content/configure-ai-account.html
https://www.filemaker.com/redirects/fmm22_admin.html?page=tech_specs&lang=en
https://help.claris.com/en/pro-help/content/insert-embedding-in-found-set.html
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• Show summary displays a summary dialog at the end of the operation, 

showing the number of records successfully processed and any errors 

encountered. 

• The Perform Semantic Find script step includes these improvements: 

• You can directly specify an image to query by. Previously, to find images similar 

to a given image, you had to query by vector data and supply the image's 

embedding vector. Now, set the Query by option to the new Image value, 

then for the Image option, specify an expression whose result is the image as 

container data (usually a container field or a variable). The script step now 

obtains the image's embedding vector itself using the specified model. 

• Performance is improved, particularly in hosted files when text or image data 

is in one table and the embedding vectors are in another table or another file. 

Access FileMaker data via Claris Studio 

• Starting with FileMaker 2025, you can now easily display and update FileMaker data 

via Claris Studio views, extending your FileMaker Pro custom app to external 

stakeholders on the web. For example, use Claris Studio views to present project 

status, a product catalog, or a dashboard of quarterly results from your 

FileMaker data, or to update your FileMaker data by capturing text and images 

directly from customers or adding comments to project tickets. 

• To set up Claris Studio to access FileMaker data, host your custom app with 

FileMaker Server 2025, then in Claris Studio, add tables from the hosted app as 

FileMaker data sources in Claris Studio. For details, see Work with data sources in 

Claris Studio Help. 

Note  With the availability of FileMaker data sources in Claris Studio, the ability to add 

Claris Studio tables in a FileMaker Pro file has been removed in FileMaker Pro 2025. 

Claris Studio tables that you added to a file in earlier versions of FileMaker Pro continue to 

work when you open them with a FileMaker 2025 client or host; only the ability to add 

Claris Studio tables has been removed. 

Improved user experience in macOS 

Home window: 

• When you start FileMaker Pro, you're greeted with the new Home window. It opens 

to the Favorites or Recent tab to give you quick access to your FileMaker Pro custom 

apps, depending on which tab you last used. The Create and Open buttons are 

positioned to make these common actions easy to find. 

• For FileMaker Cloud users, the My Apps window is now the FileMaker Cloud window. 

Rather than always opening when you start FileMaker Pro, the FileMaker Cloud 

window is only one click away on the Home window. 

• Tips: 

• To delete a favorite, select it, then press the Delete or Backspace key. 

• To add a recent app as a favorite or delete a recent app, right-click the app, 

then choose Add to Favorites or Remove. 

https://help.claris.com/en/pro-help/content/perform-semantic-find.html
https://help.claris.com/en/studio-help/content/filemaker-data-sources-in-claris-studio.html
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Status toolbar: 

• In Browse, Find, and Preview modes, new icons bring familiar functionality a fresh 

look. 

Layout mode: 

• In addition to new icons, the status toolbar gives you more customization options. The 

layout tools are now separated into individual items you can add, delete, or rearrange 

as you prefer. The tools that were previously available only after you click-and-hold 

are now available either together in a drop-down list or as individual tools you can 

place on the status toolbar. 

• The objects pane (left) and the Inspector (right) have also been given a fresh look with 

new icons and colors, as well as better spacing and typography. 

Table View: 

• System-wide light and dark appearances are now supported, including the system 

text, background, accent, and highlight colors. To enable, in Table View, right-click a 

column heading, choose Table View > Properties, then select System appearance. 

• The enhanced user experience includes a new Comfortable formatting option in the 

Table View Properties dialog that provides improved readability with scaled fonts, 

better cell padding, system focus ring in a selected cell, and refreshed icons. 

• Additional options in the Table View Properties dialog let you use alternating row 

colors and add row numbers on the left side. 

Script steps 

New script steps: 

• Go to List of Records: Goes to a layout and returns the found set specified by a list of 

record IDs. You can provide the record IDs as a list of values separated by carriage 

returns, a JSON array of record IDs as strings or numbers, or a JSON array of objects 

with recordId keys and values. Record IDs can be obtained using the new 

GetRecordIDsFromFoundSet function. 

Script step enhancements: 

• The Replace Field Contents script step now has a Perform auto-enter options for 

fields option, giving you control over whether other fields with auto-enter options are 

updated as this script step updates records. 

• The Add Account, Delete Account, and Enable Account script steps support OAuth and 

external server account types in addition to FileMaker file accounts, making it easier 

to automate the creation and management of accounts that use external identity 

providers. 

• The length limitation for the Insert Text script step has been increased from 30,000 to 

250,000,000 characters. 

https://help.claris.com/en/pro-help/content/go-to-list-of-records.html
https://help.claris.com/en/pro-help/content/replace-field-contents.html
https://help.claris.com/en/pro-help/content/add-account.html
https://help.claris.com/en/pro-help/content/delete-account.html
https://help.claris.com/en/pro-help/content/enable-account.html
https://help.claris.com/en/pro-help/content/insert-text.html
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Functions 

New functions: 

• GetTextFromPDF: Returns the text found in a PDF file in the specified container field. 

Can be used to include PDF text in finds, add PDF text to a RAG space with the 

Perform RAG Action script step, or otherwise make it available to AI models. 

• GetRecordIDsFromFoundSet: Returns record IDs from the current found set as a list or 

a JSON array. The record IDs can optionally be returned as values and ranges of 

values. The output can be used with the new Go to List of Records script step. 

• JSONParse: Parses text as JSON data and keeps the parsed JSON representation in 

memory for you to reuse with other JSON functions. You can significantly improve 

performance of JSON calculations that reuse the same JSON data many times by using 

this function first, for example, to store the result in a variable: 

Set Variable [ $json ; Value: JSONParse ( "[3]" ) ] 

• JSONParsedState: Examines the input passed into it to determine whether it has 

parsed JSON data as part of it (that is, JSON data previously parsed by the JSONParse 

function). The function returns 0 if JSON is not parsed, -1 if parsed but invalid, or a 

positive number representing the JSON type if parsed and valid. 

Script Workspace 

• The Script Workspace now lets you collapse and expand blocks of control script steps 

(for example, If, Loop, and Open Transaction) to provide a better overview of complex 

scripts. Hold the pointer over the area between the line numbers and the script, then 

click the triangle to collapse or expand the steps. Or you can select a step, 

choose Edit > Expand/Collapse Steps, then choose to expand or collapse the selected 

step, the selected step and all of its substeps, or all steps in the script. For keyboard 

shortcuts, see Script Workspace keyboard shortcuts (Windows) or Script Workspace 

keyboard shortcuts (macOS). 

Database design and management 

• In the Settings dialog on the Layout tab, the new Update layouts when the schema 

changes option (unselected by default) lets you control whether FileMaker Pro 

updates layouts to match changes made in the Manage Databases dialog. For 

example, when selected, deleting a field in Manage Databases deletes all field objects 

using that field from all layouts. The existing Add newly defined fields to current 

layout setting is still available to select separately. 

• Table comments can be added in the Manage Database dialog, similar to field 

comments, making it easier to document table structure and purpose. 

• In the Manage Database dialog, the field list displays in the Type column the data type 

for the results in calculation fields, making it easier to identify the data type without 

opening the Specify Calculation dialog for each field. 

• To help you organize your custom functions, you can work with them in folders. In the 

Manage Custom Functions dialog, you can create, rename, and delete folders as well 

https://help.claris.com/en/pro-help/content/gettextfrompdf.html
https://help.claris.com/en/pro-help/content/getrecordidsfromfoundset.html
https://help.claris.com/en/pro-help/content/jsonparse.html
https://help.claris.com/en/pro-help/content/jsonparsedstate.html
https://help.claris.com/en/pro-help/content/script-workspace-shortcuts-windows.html
https://help.claris.com/en/pro-help/content/script-workspace-shortcuts-os-x.html
https://help.claris.com/en/pro-help/content/script-workspace-shortcuts-os-x.html
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as arrange custom functions in them, nesting folders as needed. You can also use the 

Search box to filter the list of custom functions. In the Import Custom Functions 

dialog, you can select a folder to conveniently import all the custom functions in the 

folder. 

Layouts 

• In Layout mode, you can now add objects to existing groups by selecting both the 

group and the object to be added without needing to ungroup first, streamlining the 

process of organizing layout objects. Similarly, you can remove objects from existing 

groups. Use the Arrange > Add to Group or Remove from Group menu commands or 

the equivalent in the Position tab in the Inspector. 

Upgrade to major releases using Check for Updates 

• FileMaker Pro 2025 is the first major release that you can upgrade to from the latest 

version of the previous major release (FileMaker Pro 2024) by clicking Help > Check 

for Updates or when the Software Update dialog opens when you start FileMaker Pro, 

if you have an eligible license. 

• Windows: Previously, major FileMaker Pro releases were installed alongside any 

previous versions you had installed. Starting with FileMaker Pro 2025, installing the 

latest major version of FileMaker Pro replaces the previous version. 

Save a Copy as XML 

• When a FileMaker Pro file is saved using Save a Copy as XML, the root FMSaveAsXML 

element of the XML file now includes a Has_DDR_INFO attribute that's set to True 

when the Include details for analysis tools option is selected. This attribute allows 

analysis tools to quickly determine whether the file includes the DDR_INFO element 

containing additional information without parsing the entire file. 

Application 

• References to "Microsoft Azure AD" have been updated to "Microsoft Entra ID" 

throughout FileMaker Pro, reflecting Microsoft's renaming of their identity and access 

management services. 

• Theme recovery has been improved to handle cases where a theme becomes 

corrupted or is missing. If the catalog data is corrupted and the index list is lost, the 

theme data is now used to rebuild the index list, preserving layout design even when 

themes are damaged. 

Security 

• Use of the OpenSSL library is now optimized with additional compiler flags, improving 

performance for cryptographic operations and reducing the loading of deprecated 

components. 

 

https://help.claris.com/en/pro-help/content/save-a-copy-as-xml.html
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Updated libraries and packages 

The following third-party libraries have been updated to the indicated versions: 

• Antlr 4.13.1 

• date 3.0.3 

• International Components for Unicode (ICU) 76.1 

• iODBC 3.52.16 

• JSON Web Token C++ library (jwtcpp) 0.7.0 

• libxml2 2.13.5 and libxslt 1.1.42 

• OpenCV 4.11.0 

• PDF-Writer 4.6.6 

• PDFium 6957 

• Skia 126 

• speller v22 

• ZBar 0.23.93 

Addressed issues 

Layouts 

• After a card window was closed, some objects on the layout lost their background 

color. 

• Drop-down list and calendar icons did not appear for fields that were not initially 

visible when loading a layout, only becoming visible when hovering over the field or 

clicking it. 

• Windows: In Layout mode, a portal would shrink to zero height after changing options 

in the Portal Setup dialog, making the portal apparently disappear from the layout. 

• Layout calculations didn't follow conditional formatting rules for numbers with 

negative values, displaying them without the expected formatting. 

• Layout calculations didn't respond to Hide object when conditions. For example, 

when a layout calculation was set to hide when Self = 1, it remained visible regardless 

of the condition. 

• In List View, layout objects that spanned parts were drawn outside the parts when 

scrolling or resizing the window, causing graphic defects. 

• The background image specified for a layout part was not trimmed to the part 

boundary, causing elements like navigation bars in adjacent layout parts to disappear 

when they should remain visible. 

• macOS: After typing in a pop-up menu that's inside a card window, pressing 

Command-W to close the card caused FileMaker Pro to quit unexpectedly. 

• When Slide up based on was selected for a vertical line object, the line moved to the 

left by 0.5 px in Preview mode compared to its original position. 

• Windows: When switching to List View, if a record was partially displayed at the 

bottom of the window, scrolling the window sometimes caused field data not to be 

displayed in a subsequent record until after you clicked in a field in that record. 

• macOS: In Layout mode, after switching between layouts, clicking layout objects failed 

to select them under some circumstances. 
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• Deleting a field in the Manage Database dialog removed the field object and label 

from the current layout and every second layout thereafter. Now, deleting a field 

deletes the objects and labels from all layouts. 

• Windows: In web viewers, the Edit menu commands Cut, Copy, Paste, Clear, and 

Select All didn't work. 

Script Workspace 

• The script editing pane lost focus after dragging steps to rearrange them, causing 

keyboard input to be ignored until the script editing pane was clicked again. 

• In the script editing pane, the Paste script step showed No style when Paste without 

style was unselected and showed nothing when it was selected, which is the opposite 

of what should appear in this script step. 

Script steps 

• After running the Perform Script script step with a script folder, rather than a script, 

specified by name, Get(LastError) returned error code 0 ("No error"). Now, it returns 

error code 104 ("Script is missing"). 

• After running the Insert Embedding script step with any of the required options 

empty, Get(LastError) returned error code 0 ("No error"). Now, it returns error code 

10 ("Requested data is missing"). 

• When a Close Window script step was performed within a transaction, the transaction 

was properly reverted, but the Get(TransactionOpenState) function incorrectly 

returned 1 instead of 0, indicating the transaction was still open. 

• After Perform Script on Server with Callback ran the callback script and the callback 

script then used Perform Script to run another script, Get(ScriptResult) incorrectly 

returned the result from the original Perform Script on Server with Callback script step 

instead of the result from the Perform Script script step. 

• In FileMaker Go, Tab keyboard shortcuts and Go To Object script steps didn't work 

with buttons, preventing keyboard navigation to buttons and programmatic focus 

control. 

• When using the Insert from URL script step to insert a .zip file into a container field, 

the file was inserted but with incorrect metadata. The file size showed as "?", the 

filename was empty, and the MD5 value couldn't be calculated. 

• Windows: When the system default email client was a MAPI email application (such as 

Mozilla Thunderbird) but Microsoft Outlook wasn't installed, the Send Mail script step, 

when set to send via an email client, displayed an error message that a supported 

email client wasn't found. Now, the error displays only when no MAPI email 

application is found as the system default. 

• macOS: When using the Send Mail script step to send via Microsoft Outlook as the 

email client, FileMaker Pro failed to open Outlook if the record set included a record 

with an empty To, CC, or BCC field. 

• When the Open URL script step was run with an fmp:// URL that included an account 

and password, the Open "Filename" dialog opened, requiring the user to enter 

credentials instead of opening the file directly. 
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• The ExecuteSQL function with a SQL statement that included an IN operator returned 

no results, even though the same query without the IN operator returned results 

correctly. 

• When using the Save a Copy as Add-on Package script step, container data wasn't 

included in the record XML. The resulting add-on didn't have data in the container 

when added to other FileMaker Pro files. 

Functions and calculations 

• Carriage return (Char(13)) characters in variables were changed to linefeed (Char(10)) 

characters when the variables were used in a chart object, causing unexpected 

behavior in code that relied on specific character values. 

• The EvaluationError function returned 0 when used with ExecuteSQLe, even when the 

SQL statement failed, instead of returning the expected error code. 

• SQL queries returned "?" for 4-byte UTF-8 characters, causing issues with emojis and 

certain Asian language characters. 

• FileMaker Pro quit unexpectedly when evaluating calculations in a Show Custom 

Dialog script step under some circumstances. 

• When a layout was refreshed, hidden merge fields based on calculation fields were 

evaluated even though hidden calculation fields weren't, causing unexpected 

calculation behavior. 

• The ConvertToFileMakerPath function added the root drive or volume when 

converting a file path, even if the root drive or volume was already present in the 

path. 

• The JSON functions returned an error when brackets were used in keys. 

• The JSONDeleteElement function returned an error instead of deleting an element 

when given an array of null values. 

• The Timestamp function didn't correctly interpret 24-hour format time data in stored 

calculation fields when the system's region was set to Korea and 24-hour format was 

enabled. 

Application 

• Error handling for dictionary loading has been improved to prevent the "Cannot load 

main spelling dictionary" error from interrupting your work, especially when spell 

checking is disabled. 

• Custom menus were not properly removed when pasted into the Manage Custom 

Menus dialog and then canceled, leaving behind blank custom menus. 

• macOS: After resizing the Edit Custom Function dialog, the first column of characters 

in the calculation were cropped by the left edge of the calculation area and were no 

longer viewable in certain situations. 

• Windows: In a field that uses a value list and has the Allow editing of value list option 

selected, clicking the field in Browse mode, choosing Edit, selecting text in the Edit 

Value List dialog, right-clicking the text, and choosing Copy didn't copy the selected 

text to the clipboard. 

• In Preview mode, moving the slider in the status toolbar all the way to the right did 

not immediately go to the final page as expected. Instead, the preview only moved 

forward a few pages at a time. 
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• References to scripts in custom menu items were lost when copying custom menu 

items to another file. The result was "Script missing" errors even when scripts with 

matching names existed in the target file. 

• Japanese table and field names in the ExecuteSQLe function appeared as garbled 

characters when checking execution results in the Data Viewer. 

• When specifying a field, the field list was sorted in an order that didn't always match 

the order set in the Manage Database dialog. 

• When updating web viewers with JavaScript charts, FileMaker Pro consumed 

increasing amounts of memory over time. 

• Windows: When uploading a file to FileMaker Server, creating a new folder in the 

upload destination and double-clicking to rename it with multibyte characters 

resulted in garbled text. 

• When opening an FMP12 file using an fmp:// URL that included an account and 

password, FileMaker Pro on macOS and FileMaker Go failed to authenticate with the 

included account or password if they contained Unicode characters such as those with 

diacritical marks. 

• In the relationships graph, pressing Ctrl+A (Windows) or Command-A (macOS) under 

certain conditions caused FileMaker Pro to quit unexpectedly. 

• Windows: In the Manage Security dialog, the Description column was missing. 

• In the Set Variable script step, when editing formulas in Japanese, text disappeared 

when inserting or erasing line breaks in specific positions within the formula. 

Data handling and validation 

• Performing a find on timestamp fields (using the >= operator) in a large, local file 

could corrupt the file, causing it to become inaccessible after closing. 

• The Specify Calculation dialog for the Display custom message if validation 

fails option incorrectly showed the data type of the field being validated instead of 

always showing "Calculation result must be Text." 

• When importing data from an Excel file, a cell with the text value "nan" was imported 

as 0. 

• For a field in a related table that was validated by a calculation that used the Self 

function and had a custom validation message that also used the Self function, the 

validation message was blank when validation failed. 

Save a Copy as XML 

When a FileMaker Pro file was saved using Save a Copy as XML: 

• When copying and pasting a button with a script step, the pasted button's script step 

had a blank UUID in the XML file. Additionally, when duplicating a button by pressing 

Command and dragging, the duplicated button's script step retained the same UUID 

as the original instead of generating a new one. 

• Field access rules weren't reflected in the XML for fields that weren't explicitly 

modified in the Custom Field Privileges dialog, causing incomplete representation of 

security settings in exported XML. 

• Icon images specified in the File Options dialog weren't referenced correctly in the 

XML. 

https://help.claris.com/en/pro-help/content/save-a-copy-as-xml.html
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• Function name text was changed, causing differences in text case for functions and 

operators in calculations even when no actual changes were made. 

• For a style that was not saved to a theme, the expected style information was missing 

from the LocalCSS element. 

• When layout objects that contain other objects (for example, grouped objects, 

portals, tab controls) are duplicated by pressing Alt (Windows) or Option (macOS) as 

you drag them, the UUID values of the inner objects were duplicated rather than 

assigned new values. 

• Objects inside a group of objects that was inside a portal were represented twice in 

the XML. 

• The CalcsForCustomFunctions element in the XML for each custom function was 

missing a DDRREF key. 

• The DDRREF values in the XML changed with each save, causing analysis tools to 

incorrectly detect changes when comparing files. Now, rather than generate a new 

value on each save, many elements now use the existing UUID of the catalog member 

(or its parent node) as the basis of the DDRREF value. 

• Popovers weren't represented as LayoutObject elements in the XML, making it 

inconsistent with other object types and causing issues for database analysis tools. 

• The access attribute of the top-level Fields element's in the XML had a generic value 

like "ReadOnly" even when fields had mixed access levels. Now, this attribute has the 

value "Custom" to indicate custom privileges. 

Platform Product Updates Version Download Languages 

Windows 
FileMaker Pro 

2025 
22.0.1 

FileMaker Pro 22.0.1 Updater (setup.exe) 

 

English  

French 

Arab 

Hebrew 

Indian 

Thai  macOS 
FileMaker Pro 

2025 
22.0.1 

FileMaker Pro 22.0.1 Updater 

 

 

APIs, technologies, or features to be deprecated 
As FileMaker Pro evolves, the list of supported technologies, APIs, and features will change. As part of this 

evolution, certain operating systems versions, hardware, and features may be deprecated in favor of 

newer ones. Although deprecation does not mean the immediate deletion of an item, you should migrate 

your solution away from deprecated technologies, because these technologies may be removed in a 

future version of the product. 

For the latest information about deprecated APIs, technologies, and features, search the Knowledge Base. 

https://download.winsoft-international.com/7d600de4c494c16e89b6d5eef5bg2c86/Update/FileMaker/FM22/fmp_updater_22.0.1.29_me_x64.exe
https://download.winsoft-international.com/7d600de4c494c16e89b6d5eef5bg2c86/Update/FileMaker/FM22/fmp_updater_22.0.1.29_me.zip
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